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Abstract

Detrusor smooth muscle (DSM) cells present within the urinary bladder wall ultimately facilitate 

urine storage and voiding. Preparation of the viable, fresh, and isolated DSM cells presents an 

important technical challenge whose achievement provides optimal cells for subsequent functional 

and molecular studies. The method developed and elaborated herein, successfully used by our 

group for over a decade, describes dissection of human urinary bladder specimens obtained from 

open bladder surgeries followed by an enzymatic two-step treatment of DSM pieces and 

mechanical trituration to obtain freshly isolated DSM cells. The initial step involves dissection to 

separate the DSM layer (also known as muscularis propria) from mucosa (urothelium, lamina 

propria, and muscularis mucosa) and the adjacent connective, vascular, and adipose tissues 

present. The DSM is then cut into pieces (2–3 mm x 4–6 mm) in nominal Ca2+-containing 

dissection/digestion solution (DS). DSM pieces are next transferred to and sequentially treated 

separately with DS containing papain and collagenase at ~37 °C for 30–45 min per step. 

Following washes with DS containing enzyme-free bovine serum and trituration with a fire-

polished pipette, the pieces release single DSM cells. Freshly isolated DSM cells are ideally suited 

for patch-clamp electrophysiological and pharmacological characterizations of ion channels. 

Specifically, we show that the TRPM4 channel blocker 9-phenanthrol reduces voltage-step evoked 

cation currents recorded with the amphotericin-B perforated patch-clamp approach. DSM cells can 

also be studied by other techniques such as single cell RT-PCR, microarray analysis, 

immunocytochemistry, in situ proximity ligation assay, and Ca2+ imaging. The main advantage of 

utilizing single DSM cells is that the observations made relate directly to single cell characteristics 
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revealed. Studies of freshly isolated human DSM cells have provided important insights 

characterizing the properties of various ion channels including cation-permeable in the urinary 

bladder and will continue as a gold standard in elucidating DSM cellular properties and regulatory 

mechanisms.

Keywords

Immunology and Infection; Issue 155; urinary bladder; smooth muscle; detrusor; cell isolation; 
enzymatic; human; patch-clamp; amphotericin-B

Introduction

Detrusor smooth muscle (DSM) cells constitute the most abundant cell type in the urinary 

bladder and ultimately control urine storage and voiding through relaxation and contraction, 

respectively. DSM cells form smooth muscle bundles that intertwine with adjacent 

connective tissue, nerve processes, interstitial cells, and other cell types1. The current 

understanding of the role of DSM cells in urinary bladder function has been achieved 

through a multi-level integrated approach. Each experimental method - whether based on 

isolated single cells in vitro, tissue strips containing smooth muscle bundles in vitro/ex vivo, 

or in vivo determinations (such as cytometry and voiding function assessments) - provides 

important and specific insights into physiological and pharmacological properties of DSM 

(please see reviews1,2,3,4,5,6 for details). However, interpretation of results obtained from 

isolated single cells allows conclusions to be specifically attributed to the single cell type 

itself. This realization has been the driving force for establishing a reliable and reproducible 

method for obtaining freshly isolated DSM cells from the whole thickness urinary bladder 

specimens. Unlike many other cell types, smooth muscle cells cannot be reliably cultured 

due to the loss of their native phenotype including specific changes in their 

electrophysiological and contractile properties7,8. This fact further reinforces the importance 

of studies carried out on physiologically active freshly isolated DSM cells.

In the late 1980’s and early 1990’s, Isenberg’s group (Germany) published a series of 

electrophysiological studies on freshly isolated DSM cells obtained from guinea pig urinary 

bladders9,10,11,12,13 (Table 1). The method highlighted two important observations that aided 

in obtaining vital cells and served as an initial guideline for others to follow. They were 1) 

pre-treating isolated DSM pieces with Ca2+-free solution/medium prior to enzymatic 

treatment and 2) tissue digestion with a solution containing collagenase. These two critical 

steps have been incorporated into all the subsequent variants of DSM cell dissociation 

procedures (Table 1). Currently, our group employs a two-step sequential papain-collagenase 

dissociation approach. DSM pieces are first treated with an enzyme solution containing 

papain and then with collagenase type II solubilized in the same solution (DS, dissection/

digestion solution). This approach yields single DSM cells from various species including 

guinea pig, pig, rat, mouse, and importantly human (Table 1).

Single DSM cells provide a source for multiple molecular biology and physiological 

experiments. So far, protein and mRNA expressions studied with immunocytochemistry, or 

RT-PCR/qRT-PCR determinations revealed high levels of detection for various ion channels 
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including the large conductance voltage- and Ca2+-activated (BK), small conductance Ca2+-

activated K+ type 3 (SK3), voltage-gated K+ (Kv), L-type voltage-gated Ca2+ (Cav), and 

transient receptor potential melastatin type 4 (TRPM4) channels, as well as a Na/Ca2+ 

exchanger14,15,16,17,18,19,20,21,22. They are all thought to control DSM excitability, 

intracellular Ca2+ levels and contractility. Patch-clamp electrophysiological approaches, 

performed directly on guinea pig, mouse, rat, or human DSM cells, provided direct 

demonstration of biophysical and pharmacological properties of L-type Cav, Kv (Kv2.x. 

Kv7), SK, BK, and TRPM4 channels17,19,20,21,22,23,24,25,26,27,28,29,30,31. The approaches 

included a conventional whole-cell voltage-clamp, a perforated voltage-clamp, and single-

channel recordings (cell attached, inside-out and outside-out configurations). Additionally, 

membrane potential recording of DSM using a current-clamp provided evidence that target-

engaging pharmacological agents alter the cell excitability. For example, the TRPM4 

inhibitor 9-phenanthrol induced hyperpolarization in DSM cells obtained from humans, 

guinea pig, and rat urinary bladders19,20,22,31. Among the various electrophysiological 

methods, the amphotericin-B (and nystatin, gramicidin, and β-escin) perforated patch-clamp 

recordings provide a key advantage by preserving intrinsic intracellular signaling molecules 

and pathways. Only low molecular weight cations and to a lesser extent, Cl- - but not 

proteins or signaling molecules including Ca2+ - are permeable through the plasma 

membrane pores formed by amphotericin-B or nystatin32. The successful outcome of 

perforated patch-clamp experiments depends on several general variables unique to this 

technique. Here, we describe the details of the procedure utilizing amphotericin-B that our 

group has used successfully over the years15,22,33,34,35,36,37,38,39.

Arguably, non-selective cation channels remain one of the least understood channel types in 

DSM cells. The first report of a non-selective cation-like channel dates back to 1993. The 

paper by Wellner and Isenberg11 described a 33 pS stretch-activated single channel 

displaying the following rank order of ion permeability: K+>Na+≥Cs+>>>Ba2+>Ca2+, and 

inhibition of channel activity by Gd3+, a general inhibitor of non-selective cation channels. 

Almost a decade later, Thorneloe and Nelson40 described Na+ permeable cation currents in 

mouse DSM cells, inhibited by Gd3+, using whole-cell recordings. Since molecular 

identities of non-selective cation channels and their biophysical characterizations remain to 

be determined, future investigations in this research area are warranted. The protocol 

described herein for the recording of non-selective cation channel currents - using 

extracellular and pipette intracellular solutions containing Cs+, TEA+, and nifedipine (Table 

2) that physiologically and pharmacologically mitigate Kv and Cav currents - has been and 

will continue to be useful in electrophysiological investigations of non-selective cation 

channels. We have utilized this specific protocol to determine the extent of inhibition of 

whole-cell cation currents by the TRPM4 channel blocker 9-phenanthrol in guinea pig, rat 

and human DSM cells19,20,22.

Taken together, the method described here for obtaining freshly isolated single DSM cells 

from human urinary bladder provides viable cells highly suitable for electrophysiological 

investigations using various configurations of the patch-clamp technique, Ca2+-imaging, 

immunocytochemistry, in situ proximal litigation assay, and single cell RT-PCR/qRT-PCR as 

well as advanced molecular biology techniques including microarray analysis, RNA-seq, 

and CHIP-seq. The use of the amphotericin-B perforated patch-clamp method preserves the 
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native cell environment unlike other configurations. When carried out using the specific 

conditions outlined here, designed to negate contributions of K+ and Ca2+ currents in DSM 

cells, voltage-step induced currents display the properties of non-selective cation currents 

suitable for biophysical and pharmacological characterizations.

Protocol

All methods described here have been approved by Institutional Review Board Committees 

of the University of Tennessee Health Science Center (Memphis, TN, IRB# 17–05714-XP), 

and the Medical University of South Carolina (Charleston, SC, IRB# 00045232). The 

approved procedures allow whole thickness urinary bladder specimens (>1 cm by >1 cm) - 

containing all layers including mucosa, detrusor smooth muscle, and serosa as well are 

attached blood vessels and adipose tissue) - to be collected from patients-donors undergoing 

surgical partial extraction of bladder. Patient-donors are adult (age range studied until now: 

25 to 87 years old), either male or female, with or without symptoms of overactive bladder 

(as classified by American Urological Association I-PSS score41). Surgical procedures 

involve a variety of medical conditions including radical cystectomy for urothelial 

carcinoma, and adenocarcinoma. In such cases, the collected urinary bladder specimen is 

remote from the site of tumor.

1. Dissection of DSM tissues and preparation of mucosa-free DSM pieces

1. Examine the whole thickness urinary bladder specimen that arrived in the lab 

from the operating room in a tightly sealed container filled with the cold 

dissection/digestion solution (Figure 1 and Table 2 for composition of DS).

NOTE: The specimen is usually kept in cold DS from a few hours to overnight 

prior to arrival in the laboratory. For longer storage, DS (Table 2) is 

supplemented with 1 mM CaCl2.

2. Remove and rinse the human whole thickness DSM specimen (containing all 

layers including mucosa, DSM, and serosa) with ice-cold DS to wash out 

attached debris and blood.

3. Pin the urinary bladder specimen, mucosa facing upward and serosa down, onto 

a silicone enantiomer-coated (Table of Materials) 150 mm diameter round dish 

filled with ice-cold DS (Figure 1B).

4. Remove the adjacent adipose tissue, blood vessels, epithelium (urothelium) and 

muscularis mucosa from the specimen by sharp dissection using microscissors 

and forceps.

5. Cut out several mucosa-free DSM pieces (~2–3 mm long and 4–6 mm wide) 

(Figure 1C).

2. Enzymatic dissociation of DSM pieces yielding freshly isolated single DSM cells

1. Place 3 to 6 DSM pieces into a tube containing 1 to 2 mL of pre-warmed (~37 

°C) DS containing papain and dithiothreitol (DS-P, Table 2) and incubate DSM 
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pieces in DS-P for 30–45 min at ~37 °C gently shaking the tube occasionally 

(once every 10–15 min).

NOTE: To optimally control the temperature for enzymatic treatment, tubes with 

tissue pieces and enzyme solutions are placed in either a glass tissue chamber 

filled with water connected to a circulating heated water bath (Figure 1D) or a 

high-precision temperature-controlled shaking water bath (Figure 1E).

2. Remove DS-P from the tube, briefly wash DSM pieces with ice cold DS, discard 

cold DS from the tube leaving DSM pieces sitting at the bottom of the tube.

3. Add 1 to 2 mL of DS-containing collagenase type II (DS-C, Table 2) to the tube 

with DSM pieces, gently mix; and incubate for 25–40 min at ~37 °C gently 

shaking the tube occasionally (every 10–15 min).

4. Discard DS-C and wash enzyme-treated DSM pieces 5–10 times with ice-cold 

DS.

5. Following the last wash, leave DS solution inside the tube; gently triturate with a 

fire-polished Pasteur pipette several times to release single DSM cells.

6. Place a few drops of DS solution containing dispersed DSM cells onto a glass-

bottom chamber or a coverslip and visually inspect for the quality under a 

microscope (using a 20x or 40x objective) after at least 5 min following the 

application to allow the cells to adhere to the bottom.

7. Immediately use freshly isolated DSM cells for electrophysiological experiments 

or store the cells in a tube containing DS at ~4 °C either on ice or in a 

refrigerator until use (typically for up to 8 h of preparation).

NOTE: Within the same preparation the quality of cells varies from highly viable 

to over-digested, dead DSM cells (Figure 2). When the sequential papain-

collagenase method yields a very high number of unviable cells, the preparation 

is discarded, and a new digestion of DSM pieces is carried out but with reduced 

incubation intervals. If the procedure results in too few DSM cells then for the 

subsequent digestion of DSM pieces, the incubation intervals are increased. 

Positive immunoreactivity to α-smooth muscle actin confirms the identity of 

DSM cells (Figure 3).

3. Recording voltage-step induced cation currents from DSM cells using amphotericin-
Bperforated whole-cell voltage patch-clamp technique

1. Pipette 0.25–1 mL of cell suspension onto a glass bottom chamber sitting on a 

stage of an inverted microscope and allow the cells to adhere to the glass bottom.

2. After incubation for at least 45 min, remove DS from the bath and replace with 

the E solution (Table 2) by superfusion where the solution flow aided by gravity 

via inlet tubing slowing replaces DS with the new solution while outlet tubing 

connected to a vacuum waste vessel removes the chamber solution and prevents 

overflow. Note that E solution contains tetraethylammonium (TEA+) and cesium 

(Cs+) ions to inhibit K+ currents.
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3. Prepare a working stock solution of amphotericin-B in dimethyl sulfoxide 

(DMSO) (1 mg per 10 μL of DMSO). To fully dissolve amphotericin powder, 

sonicate (at least 15 min) and vortex the solution well.

NOTE: This step usually takes less than 10 min. Dissolving 3–4 mg of 

amphotericin-B in 30–40 μL of DSMO in a 1.5 mL microcentrifuge tube works 

well. Higher quantities of amphotericin-B require more DSMO solvent typically 

resulting in a longer interval for mixing and incomplete solubilization of the 

amphotericin-B solid particles present in the tube.

4. Dissolve stock solution of amphotericin-B in the pipette solution (solution P, 

Table 2) to obtain a final concentration of 200–500 μg/mL. This step requires 

extensive sonication and vortexing at a high-speed setting (8–10/10) for ~30 to 

60 min per step to ensure optimal mixing and prevention of amphotericin-B 

precipitate formation in the pipette solution.

NOTE: Amphotericin-B will precipitate over-time and is light-sensitive. The 

working pipette solution containing Amphotericin-B is checked for solubility, 

hand-mixed prior to pipette filling, and kept in the dark.

5. Pull multiple patch electrodes, fire-polish electrode tips, and (if needed) coat the 

tips with dental wax.

6. Fill the tip of a patch electrode with the pipette solution (solution P, Table 2) 

without amphotericin-B by briefly dipping the electrode in the solution.

7. Backfill the electrode with the same pipette solution containing amphotericin-B.

8. Mount the electrode onto a holder connected to a patch-clamp amplifier 

headstage.

9. Using a micromanipulator, place the electrode just below the surface of the 

extracellular solution so that the tip of the electrode is just submerged.

10. In the voltage-clamp mode, set the holding potential to 0 mV and adjust the 

current to 0 pA with the pipette offset dial on the commercial amplifier (Table of 

Materials).

11. Determine the electrode resistance using the Membrane Test window/function of 

the commercial acquisition software (Table of Materials). To activate click 

Tools>Membrane Test>Play or a shortcut icon in the software. The determined 

electrode resistance should be in the range of 2 to 5 MΩ.

NOTE: Membrane Test function provided in the commercial acquisition software 

or Seal Test option on the amplifier can be used to monitor electrode resistance 

by applying voltage steps repetitively.

12. Continue monitoring electrode resistance while advancing the electrode toward a 

chosen DSM cell with a micromanipulator (Figure 4A). NOTE: To be considered 

a viable DSM cell, the cell must show spindle-shaped elongated morphology, a 

well-defined halo around the cell, crisp edges, and semi-contractile (serpentine) 

appearance.
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13. When touching the cell surface with the electrode - indicated by a rapid increase 

in the electrode resistance measured with the Membrane Test function - form a 

giga-seal by applying gentle rapid negative pressure to the electrode holder via 

tubing. This results in negative pressure created at the tip of the electrode that 

pulls cell membrane into electrode aiding in the formation of a giga-seal or a 

very tight contact between the electrode and plasma membrane (Figure 4B).

14. Once the giga-seal forms, compensate pipette capacitance by adjusting fast and 

slow dials on the commercial amplifier and monitor giga-seal stability (leak 

current) using the Membrane Test function.

15. Allow time, typically 30–60 min, for amphotericin-B to diffuse down the pipette 

and be inserted into the plasma membrane forming pores primarily selective to 

monovalent cations. During this step, continue monitoring the giga-seal with the 

Membrane Test function. As cell perforation increases so does the amplitude of 

the capacitance transients (compare Figure 4B versus Figure 4C displaying no 

and effective cell perforation, respectively) measured with the Membrane Test 

function.

16. When the patch perforation is optimal (judged by stable series resistance 

typically below 50 MΩ), cancel out the capacitance transients by adjusting the 

dials for cell capacitance and series resistance on the amplifier. Series resistance 

compensation can also be performed at this time (Figure 4D).

17. Once stable voltage-step induced cation currents evoked by the specified 

protocol are observed, apply a compound or physiological condition to test by 

superfusion and record the responses for the control-, test-condition, and washout 

(if possible) with the commercial acquisition software.

1. Record currents with a routine voltage-step protocol that involves 

holding DSM cells at −64 or −74 mV and stepping the voltage in 10 

mV increments for 400 or 500 ms from −94 to +96 or +106 mV and 

returning to the holding potential.

NOTE: The membrane potential values are adjusted for a liquid 

junction potential of 14 mV (using P and E solutions, Table 2). The 

liquid junction potential is obtained in the commercial acquisition 

software (Table of Materials) by clicking (Tools>Junction Potentials) 

and entering the concentrations of solution ion components. A ramp 

protocol can also be used to obtain current recordings.

2. Run the voltage-protocol in continuous ~1 min interval during an 

experiment recording currents for pre-addition control, test condition, 

and washout.

4. Data analysis and visualization

1. Open recorded files in the commercial data analysis software (Table of 

Materials) for the control, test condition, and washout by clicking File>Open 
Data and selecting files of interest for opening.
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NOTE: For analysis typically three files (each containing a single set of traces to 

a single protocol run) for each condition are opened and analyzed. The responses 

are subsequently averaged to obtain a mean response for each condition. The 

software used for data acquisition contains an option to automatically collect 

user-specified multiple test runs and average them for single output file that can 

be used as an alternative.

2. Obtain the average response over the last 200 ms for the current trace measured 

at each voltage; the duration interval chosen reflects a steady-state level of 

voltage-step current activation. To do so follow the steps below.

1. Select a file of interest for analysis in the commercial analysis software 

(Table of Materials).

NOTE: The software positions the most recently imported file into its 

active display window. The open file displays a series of overlapping 

traces obtained with a voltage-step protocol. By default, within the 

active window four cursors (displaying x and y values for the 

highlighted trace) are shown.

2. Choose the range for analysis by positioning cursor 2 at the end of the 

400 or 500 ms voltage step and cursor 1 at the interval of 200 ms before 

that so that the analysis range is 200 ms.

3. Obtain responses for each voltage by clicking Analyze>Quick 
Graph>IV (or the IV shortcut icon) (in the prompt window before 

generating data confirm that for y-axis (Current) signal Region options 

“Cursors 1..2” and “Mean” are selected). Click OK to generate the I-
V graph and to place the data into a Results column sheet that can be 

viewed by accessing Windows>Results.

4. Analyze additional files by repeating steps 4.2.1 – 4.2.3. Click 

Analyze>Quick Graph>IV or the IV icon shortcut, select Append 
rather than Replace to add additional data to the Results sheet when 

processing the traces.

5. Copy data to a spreadsheet by selecting the columns of interest and 

pressing CTRL+C to copy and CTRL+V to paste. Store the Results 

worksheet in the commercial analysis software (Table of Materials) in 

(*.rlt) format by clicking File>Save As.

3. For each cell, normalize the responses for all three conditions to the value of the 

maximum voltage step for the pre-addition control (according to the formula: 

Response/ResponseControl-Max) and graph the responses as current (or current 

density) values versus voltage relationships (Figure 6).

1. In a worksheet processor, determine the average responses as either 

currents (pA) or current densities (pA/pF) for control, test condition (in 

this example, 9-phenanthrol), and washout at each voltage step.
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2. Divide values for each voltage of each condition (control, 9-

phenanthrol, and washout) by the maximum control response obtained 

at the highest voltage (+96 mV in Figure 6) for the pre-addition control 

following the formula: Normalized response for condition(x) = 

Response(x)/ ResponseControl-Max for (x).

4. For summary analysis, arrange the data in a format that can be easily copied to a 

graphical program (e.g. GraphPad Prism) for visualization.

Representative Results

Enzymatic dissociation of DSM pieces provides healthy freshly isolated DSM cells routinely 

used in functional and molecular studies such as: patch-clamp electrophysiology and 

immunocytochemistry. Figure 1 summarizes the dissection steps and visualizes the setups 

employed for temperature control of enzymatic treatment steps. Figure 2 illustrates bright-

field images of DSM cells obtained from three human urinary bladder specimens each from 

a different patient-donor. Healthy single DSM cells are characterized by spindle-shaped 

morphology, crisp welldefined edges, a well-defined halo around the cell, and semi-

contractile (serpentine-like) appearance when viewed under the microscope (see DSM cells 

demarked by white arrows in Figure 2). They also respond to contraction stimulating agents 

such as the muscarinic agonist carbachol or high K+ (60 mM) applications. DSM cells show 

positive immunoreactivity for α-smooth muscle actin confirming their identity (Figure 3).

DSM cells are ideally suited for patch-clamp electrophysiological investigations of ion 

channel properties. Here, we describe the amphotericinB perforated patch-clamp recording 

method using pipette and extracellular solutions (Table 2) to optimally record voltage-step 

induced cation channels. Under the specific conditions employed, blockade of Kv and L-type 

Ca2+ currents with Cs+/TEA+ and nifedipine, respectively, ensured the elimination of 

contribution of these ionic components to the whole-cell voltage-evoked currents. Figure 4 

and Figure 5 show, respectively, the experimental steps of the amphotericin-B perforated 

patch-clamp method and representative whole-cell currents measured either with a voltage-

step induced or a ramp protocol in three different human DSM cells, each from a different 

patient donor. Note that the recordings display a certain degree of variability in terms of 

current amplitudes and outward rectification. Additional experiments revealed that 9-

phenanthrol, a TRPM4 channel inhibitor, effectively and reversibly inhibited human DSM 

cation currents at negative and positive voltages (Figure 6). The 9phenanthrol-sensitive 

current component illustrates a stronger inhibition at positive voltages and outward 

rectification (Figure 6C).

Discussion

The procedures described here explain the steps involved in the preparation of viable, freshly 

isolated DSM cells from whole thickness human urinary bladder specimens using enzymatic 

digestion and in the recording of whole-cell cation currents sensitive to the TRPM4 channel 

inhibitor 9-phenanthrol employing the amphotericin-B perforated patch-clamp approach. 

The enzymatic procedure relies on a two-step sequential exposure referred to herein as the 

sequential papain-collagenase digestion method. DSM tissues are first treated with papain 
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and dithiothreitol (an enzyme stabilizing agent) under a nominal Ca2+-free condition, 

followed in the second step by collagenase type II in the presence of low Ca2+. The rationale 

for carrying out papain digestion under low Ca2+ conditions in smooth muscle cells dates 

back to the late 1980’s. Freshly isolated carotid artery smooth muscle cells prepared with 

papain displayed an elongated shape, showed viability (resistance to Trypan Blue uptake) 

and responded to contractile stimuli (higher Ca2+ and histamine)65. Years later, this method 

was applied in the preparation of DSM cells (see Table 1). The choice of collagenase type II 

rather than other types relates to its relatively high proteolytic activity ideally suited for 

smooth muscle tissues including DSM. Indeed, collagenase treatment alone could yield 

single DSM cells albeit requiring extensive enzyme exposure (≥60 min)53,54. Since 

collagenase activity depends on Ca2+ and the enzyme is inactive under the Ca2+-free 

conditions, optimum enzymatic digestion of DSM pieces requires the presence of Ca2+ 66. In 

our case, DS-C contains 100–200 μM [Ca2+] (Table 2). After enzymatic treatment, digested 

DSM pieces are washed gently a number of times with cold DS without enzymes or Ca2+ to 

remove any enzyme bound to tissues. The ice-cold DS helps to preserve DSM cell integrity 

and to limit enzymatic activity of any remaining papain or collagenase. In the last step, 

trituration of enzyme-treated DSM pieces with a fire polished Pasteur pipette releases single 

DSM cell. DSM cells are either immediately placed onto a recording chamber for patch-

clamp studies or other types of experimentation or stored on ice in DS for use later on the 

same day (typically within 8 hrs of preparation, but the cells remain viable for up to 24 h).

We identified several important considerations for successfully obtaining single DSM cells. 

The first pertains to the human DSM specimen source quality. To optimally preserve tissue 

integrity, DSM samples obtained from open bladder surgeries are placed in ice-cold DS as 

soon as possible and maintained in a cold environment. Specifically, upon surgical extraction 

from the patient, the bladder specimen is immediately placed on a fully prepared side table 

in the operating room. Gross examination of the whole specimen (usually obtained during 

radical or simple cystectomy) and its opening follow. After visual inspection, a piece of 

whole thickness urinary ladder specimen is removed from a remote area of the specimen 

grossly uninvolved with tumor and immediately placed into a cup (either 50 or 100 mL) 

containing cold (~4 °C) Dissection Solution (DS) (Table 2) and then tightly closed with a 

lid. Due to the planned nature of the harvesting of the tissue, the operating room personnel 

and auxiliary staff doing the harvesting are alerted at the start of the surgical case in order to 

have the materials available in the operating room at the time of tissue extraction. These 

precautions along with the routine, repetitive nature of the processing steps keep the warm 

ischemia time for the tissue - from extraction to placement in the chilled container with DS 

solution - to less than 5 min. The container is then placed in a refrigerator or on ice in a 

cooler to maintain the cold environment and transported (ice-cold) to the laboratory. Once 

the specimen arrives in the laboratory, dissection and enzymatic dissociation steps 

commence. It is very difficult to predict whether a given DSM specimen will yield high 

quality DSM cells following enzymatic dissociation, so we proceed with the enzymatic 

dissociation steps. In many cases, in parallel with electrophysiological experiments, our 

group conducts isometric tension recordings on DSM strips prepared from the same DSM 

specimens. We have found that we can usually obtain high quality DSM cells from 
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preparations that also successfully provide viable strips for isometric contraction studies (our 

unpublished observation).

The second factor relates to different enzyme lot variabilities. We observed that for both 

papain and collagenase type II, each time a new lot of enzyme arrives from a supplier, the 

enzyme activity in DS for tissue digestion can vary. We, hence, routinely optimize the 

enzyme concentration and incubation intervals for each new lot. To minimize the lot 

variability contribution, we order larger quantities of the same lot and make a large batch of 

stock solutions in 2 mL aliquots of enzymes and store them at ~−20 °C until use. Over time, 

however, frozen stocks (stored up to 2 weeks) can lose their enzymatic activity. The third 

variable relates to the temperature of enzyme digestion treatments. Enzymatic activities of 

both papain and collagenase display temperature-dependency. Papain and collagenase type 

II exhibit activity in the temperature ranges encompassing normal body physiology67,68. 

Therefore, we aim to maintain the enzyme treatments stable at ~37 °C avoiding higher 

temperatures to preserve DSM cell integrity. The fourth consideration concerns the 

variability of the quality of DSM cells present within each preparation ranging from highly 

viable (exhibiting excellent classical smooth muscle characteristics) to non-healthy, over-

digested cells. A prolonged enzyme incubation interval is one of the main reasons for 

obtaining a high number of damaged cells. Excessive enzyme treatments also impair protein 

structures of ion channels, receptors, and transporters, adversely affecting their functionality. 

Interpretation of results obtained from enzymatically obtained, freshly isolated cells should 

bear this consideration in mind. Optimization of enzyme digestion conditions aims to 

increase the percentage of highly viable cells. Experimental approaches relying on a higher 

number of viable cells such as microarray analyses require more robust optimizations than 

those successfully carried out on fewer cells such as single-cell patch-clamp 

electrophysiology or Ca2+ imaging. Consideration of the aforementioned factors has guided 

our research efforts over the last decade in obtaining high quality single DSM cells.

The perforated patch-clamp technique has been a mainstay electrophysiological approach 

for over a quarter of a century. Several publications provide details of the technical 

considerations69,70,71,72,73. Cell perforation can be obtained with amphotericin-B, nystatin, 

gramicidin, or β-escin (see reference32 for overview of each). The main advantage of 

perforated patch-clamp recordings over other electrophysiological approaches is that the 

native intracellular environment - including intracellular Ca2+ and signaling molecules (e.g., 

cAMP, PKA, phosphates, and phosphodiesterases) - is preserved. This technique is, hence, 

ideally suited for investigating whole-cell ion channel currents and their regulatory 

mechanisms under near physiological conditions. A key caveat is that intracellular cell 

composition cannot be precisely controlled unlike other electrophysiological methods such 

as conventional whole-cell and single-channel excised-patch (inside- and outside-out) 

recordings. In our experience, three factors routinely contribute to successful experimental 

outcomes of amphotericin-B-perforated patch-clamp experiments. The first is the quality of 

the DSM cell chosen to attempt a recording. When DSM cells are highly viable displaying a 

semi-contractile (serpentine-like), high-contrast shiny appearance with a well-defined halo 

around the cell surface and attach tightly to the glass bottom of the recording chamber then 

giga-seal formation and cell perforation occur relatively easy. The second and third factors 

for success, respectively, relate to quality of source and solubilization of amphotericin-B (in 
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dimethyl sulfoxide/DMSO and intracellular pipette solution). We observed discrepancies 

among different suppliers in terms of source and lot variabilities. Each day we prepare a 

fresh solution of amphotericin-B stock solution from powder followed by its dilution in 

intracellular pipette solution. These steps require extensive sonication and vortexing. With 

freshly made amphotericin-B-containing pipette solution, successful cell perforation (<50 

MΩ) following giga-seal formation can be usually obtained within 30 min. The 

concentration of amphotericin-B in the pipette solution also requires optimization dependent 

on the amphotericin-B lot and source. Under our experimental conditions, the final 

amphotericin-B concentrations in the pipette range from 200 to 500 μg/mL. Since 

amphotericin-B exhibits light sensitivity, its solutions need to be kept in the dark. Using the 

amphotericin-B perforated patch-clamp technique, our group recorded voltage-step induced 

K+, Ca2+, and non-selective cation currents from human, guinea pig, mouse, and/or rat DSM 

cells17,21,22,23,29,30,31,35,60. Here, we describe conditions for recording non-selective cation 

currents in human DSM cells. 9-Phenanthrol, a blocker of TRPM4 channels, attenuated 

voltage-step induced currents supporting the role of these channels in the control of DSM 

excitability. As a note, it usually requires at least 45 min after obtaining a giga-seal and 

initiation of perforation to record optimum stable voltage-step induced non-selective cation 

currents. Voltage ramps can also be used as an alternative to voltage-step protocols30,64. 

Here, a voltage-step protocol from a hyperpolarized holding membrane potential was 

preferred rather than a ramp protocol since the former approach minimizes the effect of 

voltage-dependent inactivation and allows for averaging of evoked current over a duration of 

a voltage–step where the ramp provides a single data point per voltage. The latter point 

especially applies to human DSM cells as the currents show variable activity during voltage 

steps (Figure 5 and Figure 6). The amphotericin-B perforated patch-clamp technique has 

been essential in identifying the properties of DSM cells and other cell types and will 

continue to aide in providing novel discoveries in the future. Furthermore, freshly isolated 

single DSM cells can be successfully used for measuring whole-cell K+, Cl-, and Ca2+ 

currents with the conventional mode of the patch-clamp technique, membrane potential 

recording with the current clamp, and single channel recordings as exemplified by our prior 

reports23,29,35,64.

In addition to single cell patch-clamp methods, freshly isolated DSM cells can be studied 

with other technical approaches including Ca2+ imaging, RT-PCR/q-RT-PCR, 

immunocytochemistry, in situ proximity ligation assay, and genomic approaches (e.g., 

microarray, RNA-seq, CHIP-seq)15,18,30,33,34. As single cell transcriptome determination 

methods continue to evolve and become highly sensitive, we envision in a future ability to 

routinely and specifically link electrical or pharmacological properties of individual DSM 

cells with their transcriptome/proteome profiles. This will be achieved by first recording 

from a DSM cell and then extracting mRNA or protein followed by transcriptomic/

proteomic analyses. Although such methods have been tested already in non-DSM cells, 

they are at present technically challenging, lack sensitivity to be considered routine, and 

limited to successful detection of a few selected gene products74. Function-molecular profile 

expression linking studies when done on DSM cells obtained from urinary bladders derived 

from control and diseased patient-donors will provide insights into physiological processes 
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essential for driving normal DSM functions, pathogenesis, and in identifying effective novel 

therapeutic approaches.
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Figure 1: Summary of dissection steps resulting in the preparation of detrusor smooth muscle 
(DSM) pieces and setup used for enzymatic dissociation.
Shown are images of: (A) a whole thickness human urinary bladder specimen provided from 

an open bladder surgery as extraneous surgical material in ice-cold DS, (B) the same 

preparation after pinning with a partially dissected DSM layer, (C) DSM pieces of variable 

dimensions cut out from the DSM layer ready for enzymatic digestion (smaller pieces) or 

other experimental investigations (larger pieces), (D, E) alternative setups used for 

enzymatic digestion of DSM pieces consisting of either (1) a temperature-controlled 

circulating water bath connected via tubing to a large glass tissue chamber filled with water, 

a rubber holder for tubes, plastic tubes containing DSM pieces and enzyme solutions 

prepared in dissection/digestion solution (DS, either DS-P or DS-C, Table 2) and a 

temperature probe linked to a display allowing for continuous monitoring (D), or (2) a large 

water-filled temperature-controlled bath containing a holder and tubes with DSM pieces and 

enzyme solutions (E). Please click here to view a larger version of this figure.
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Figure 2: Representative bright-field images of human freshly isolated DSM cells obtained using 
the sequential papain-collagenase digestion method.
(A-F) Displayed are images of viable, physiologically active DSM cells considered suitable 

candidates for attempting perforated patch-clamp recordings. (G, H) Images of non-viable 

or over-digested cells; such cells were avoided for patch-clamp experiments. White and 

black arrows in panels (A-H) point to DSM cells considered viable and non-viable, 

respectively, for attempting patch-clamp recordings. Note that the black arrows in panels (A, 
C, and G) point to cell fragments (circular pieces) or small cells lacking DSM morphology 

and in (H) the cells appear pale and dilated. Images are from three different urinary bladder 

specimens (A and B : patient-donor source one, C and D : patientdonor source two, and E-
H : patient-donor source three). Please click here to view a larger version of this figure.
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Figure 3: Expressions of transient receptor potential melastatin type 4 (TRPM4) channel and α-
smooth muscle specific actin immunoreactivities in single human DSM cells by 
immunocytochemistry analysis.
(A) Shown are confocal images showing immunocytochemical detection of TRPM4 channel 

protein expression in a human DSM cell. Red staining (bottom left) indicates TRPM4 

channel proteins; blue (DAPI) staining detects cell nuclei (top left); green staining indicates 

α-smooth muscle actin (α-SMA, top right); the merged image (bottom right) illustrates the 

overlap of all three images. (B) Confocal images illustrating attenuation of 

immunocytochemical detection of TRPM4 channel protein expression in the presence of a 

TRPM4-specific competing peptide (CP) in isolated human DSM cells. Blue (DAPI) 

staining indicates cell nuclei (top left); green staining is for α-smooth muscle actin (α-SMA, 

top right); the merged image (bottom right) illustrates the overlap of all three images. The 

results were verified in four separate experiments using DSM whole tissue or multiple DSM 

cells isolated from four patients. Images are from Hristov et al. (2016)22 and used with 

permission. Please click here to view a larger version of this figure.
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Figure 4: Schematic illustration of steps involved in giga-seal formation and amphotericin-B 
perforation of human DSM cells.
Illustrated are spatial positions of an amphotericin-B containing pipette and a DSM cell 

along with associated responses for membrane tests obtained in the commercial acquisition 

software (Table of Materials) by altering voltage steps (either −10 or −20 mV in this 

example) determining resistance. Configurations are: (A) prior to the cell approach with an 

electrode, (B) after giga-seal formation obtained by positioning the amphotericin-B 

containing pipette (amphotericin-B represented by red dots) onto the cell surface and 

applying negative pressure, (C) the on-cell configuration shown ~45 min after giga-seal 

formation, at this time-point amphotericin-B has diffused down the pipette and its molecules 

have inserted into the plasma membrane at the tip of the electrode forming cation permeable 

pores, and (D) the same configuration as in (C) but with capacitance transients canceled out 

using dials for whole-cell capacitance and series resistance on the amplifier. Please click 

here to view a larger version of this figure.
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Figure 5: Whole-cell cation currents recorded with amphotericin-B perforated patch-clamp 
method in human DSM cells.
(A) A diagram of the voltage-step protocol illustrates a holding potential of −74 mV and 

voltage-steps of 400 ms duration from −94 to +96 mV carried out in 10 mV increments and 

then returned to −74 mV. (B, C) Representative current traces along with current density-

voltage plots from two different human DSM cells, each from a different urinary bladder 

specimen/patient-donor obtained with the voltage-step protocol described in (A). (D) An 

example of a current trace obtained with a ramp protocol (graphically represented in the top 

inset as voltage change from −94 to +116 mV over a 1 s duration at 0.21 mV/ms, holding 

potential was −94 mV). On the right in panels (B-D), the graphs display the current density-

voltage relationship for each DSM cell recorded. Please click here to view a larger version of 

this figure.
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Figure 6: TRPM4 channel blocker 9-phenanthrol-mediated inhibition of voltage-step induced 
cation currents in human DSM cells.
(A) Shown are representative currents measured with the voltage-step protocol described in 

Fig. 5A for control, 9-phenanthrol, and washout. (B) Summary of normalized responses 

versus voltage for control, 9-phenanthrol, and washout in seven DSM cells (from seven 

different patientdonors). (C) Difference current for 9-phenanthrol-sensitive component 

obtained by subtracting the values in the presence of 9-phenanthrol (30 μM) from those of 

the control shown in (B). Data in (B) and (C) are displayed as means with error bars for 

SEM, * depicts significance (p<0.05, paired Student’s test) for the comparison of control vs 

9-phenanthrol at each voltage. Panels (A) and (B) have been reproduced from Hristov et al. 

(2016)22 and used with permission. Please click here to view a larger version of this figure.
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Table 1:

Summary of enzymatic approaches used for isolating single DSM cells from urinary bladders of various 

species.

Species Procedure Details References

Guinea pig DSM pieces rinsed with Ca2+-free medium (in mM: 100 NaCl, 10 KCl, 1.2 KH2PO4, 5 
MgCl2, 20 glucose, 50 taurine, measured pCa=6 (or 1 mM) and then cut into pieces and 
treated typically 90–120 min (4 periods of 30 min) with enzyme medium (in mM: 130 KOH, 
20 taurine, 5 pyruvate, 5 creatine, 10 mM HEPES, adjusted with methansulfonic acid to pH 
7.4, 1 mg/ml collagenase, 0.2 mg/ml pronase E, 1 mg/ml fatty acid free albumin, pCa=4.2 
(63 mM) or 3.7 (200 mM). Single DSM cells were stored in Kraft-Bruhe (KB)-medium (in 
mM: 85 KCl, 30 K2PO4, 5 MgSO4, 5 Na2ATP, 5 K-pyruvate, 5 creatine, 20 taurine, 5 beta-
OH-butyrate, 1 mg/ml fatty acid free albumin, adjusted with KOH to pH 7.2). Alternative 
method: DSM pieces rinsed for 10 min in a Ca2+-free medium (in mM): 140 NaCl, 5 KCl, 
1.2 MgCl2, 10 glucose, 20 taurine, 5 HEPES, adjusted with NaOH to pH 7.4). Then DSM 
pieces, incubated in the same Ca2+-free medium complemented with 5 mg% collagenase, 2 
mg% pronase and 100 μM CaCl2 for 2×20 min stirring.

Klockner & Isenberg 
(1985)13,34 Klockner & 
Isenberg (1986)35 Schneider et 
al. (1991)10 Bonev & Isenberg 
(1992)9 Weidelt & Isenberg 
(2000)36 Moore et al. (2004)14

Guinea 
pig, 
Landrace 
pig, and 
human

DSM pieces pre-incubated for 5 min in Ca2+-free Krebs solution then cut into pieces and 
enzymatically digested in Ca2+-free Krebs solution containing 0.5–2 mg/ml collagenase type 
I and 0.1–0.5 mg/ml pronase at 36°C for 20–30 min constantly stirred. In some cases, 
digested pieces were further agitated by a blunt tipped pipette or by spinning until yielding 
cells. Isolated cells were stored in modified Krebs solution (described in Klockner & 
Isenberg13) and were normally used within 3 h. The composition of the Krebs solution was 
(mM): 140 Na+, 6 K+, 2 Ca2+, 1.2 Mg2+, 152.4 Cl-, 10 glucose, 10 HEPES, pH 7.35–7.4 with 
Tris. For Ca2+-free solution, Ca2+ and Mg2+ were omitted from the Krebs solution.

Inoue & Brading (1990)37 

Inoue & Brading (1991)38 

Nakayama & Brading 
(1995)39,40

Human DSM pieces placed in Ca2+-free HEPES Tyrode’s solution (in mM: 105.4 NaCl, 20.0 or 22.3 
NaHCO3, 3.6 KCl, 0.9 MgCl2, 0.4 NaH2PO4, 19.5 or 4.9 HEPES, 5.4 or 5.5 glucose, 4.5 or 
5.5 Na-pyruvate) and cut into DSM pieces. DSM pieces soaked in an enzyme solution (Ca2+ 

free HEPES solution with 0.7 mg/ml collagenase type I, 0.7 mg/ml papain, 1 mg/ml albumin) 
overnight at 4°C. The strips were then heated at 36.5°C for 15 to 30 min, washed and gently 
triturated in fresh solution. Isolated cells that were stored in Ca2+ containing HEPES 
Tyrode’s solution or used immediately for experiments.

Montgomery & Fry (1992)24 

Gallegos and Fry (1994)41 Fry 
et al. (1994)42 Sui et al. 
(2001)43 Wu et al. (2002)44

Guinea pig DSM cut into pieces in PSS (in mM: 137 NaCl, 5.4 KCl, 2 MgCl2, 2 CaCl2, 0.42 KH2P04, 
4.17 NaHCO3, 10 glucose, 10 HEPES, pH 7.4 with NaOH). DSM pieces placed for 10 min 
in in the following digestion solution (in mM: 80 Na-glutamate, 55 NaCl, 6 KCl, 10 HEPES, 
11 glucose, 2 MgCl2, and 0.2 CaCl2) and then transferred to a vial containing the same 
solution but with 1 mg/ml collagenase 2, 1 mg/ml trypsin inhibitor (sometimes omitted), 1 
mg/ml fat-free bovine albumin, for ~ 70 min at 35°C or ~60 min at 37°C. Single DSM cells 
were obtained by trituration through a Pasteur pipette in the same solution without calcium 
and enzymes. After trituration, Ca2+ (1 mM) was added and the cells were stored at 4°C. The 
cells were always used on the same day.

Bonev & Nelson (1993)53,54 
Heppner et al. (1997)26 Petkov 
et al. (2001)47 Shieh et al. 
(2001, 2007)48,49

Guinea 
pig, 
mouse, rat, 
and human

Protocol utilizes a two-step enzymatic dissociation treatment following sharp dissection in 
Ca2+-free digestion solution (in mM: 80 Naglutamate, 55 NaCl, 6 KCl, 10 HEPES, 11 
glucose, and 2 MgCl2). First, DSM pieces were treated for 25–45 min at 37°C with 1–2 
mg/ml papain, 1 mg/ml dithioerythreitol and 1 mg/ml bovine serum albumin in dissociation 
solution (in mM: 80 monosodium glutamate, 55 NaCl, 6 KCl, 2 MgCl2, 10 HEPES, and 10 
glucose, adjusted to pH 7.3 with NaOH) and then DSM pieces transferred to digestion 
solution containing 1–5 mg/ml collagenase XI (Sigma) or collagenase type 2, 1 mg/ml 
bovine serum albumin, 0 or 1 mg/ml trypsin inhibitor and 100 μM Ca2+, for 6–30 min. 
Following incubation, the digested tissue was washed several times in digestion solution 
without enzymes and Ca2+ and then gently triturated to yield single smooth muscle cells.

Petkov et al. (2001)50 

Thorneloe & Nelson (2003)51 

Thorneloe & Nelson (2004)33 

Petkov & Nelson (2005)27 

Hristov et al. (2008)52 Layne et 
al. (2010)53 Hristov et al. 
(2011)15 Xin et al. (2012)54 

Parajuli et al. (2012)25 Malysz 
et al. (2013)29 Parajuli et al. 
(2013)31 Lee et al. (2013)55 

Malysz et al. (2014)23 Smith et 
al. (2013)19,20 Hristov et al. 
(2016)22 Lee et al. (2017)56 

Yarotskyy et al. (2018)57
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Table 2:

Compositions of dissection/digestion solution (DS), and pipette and extracellular solutions used in perforated 

patch-clamp experiments.

Solution Type Composition (in mM)

DS (Dissection/Digestion 
Solution)

80 Na-glutamate, 55 NaCl, 6 KCl, 10 HEPES, 2 MgCl2, and 11 glucose, pH adjusted to 7.4 (with 10 M NaOH)

DS-P (Papain-containing 
DS)

DS containing 1–2 mg/ml papain, 1 mg/ml dithiothreitol and 1 mg/ml bovine serum albumin

DS-C (Collagenase-
containing DS)

DS solution containing 1–2 mg/ml collagenase type II, 1 mg/ml bovine serum albumin, 0 or 1 mg/ml trypsin 
inhibitor and 100–200 μM Ca2+

P (Pipette) 110 CsOH, 110 aspartic acid, 10 NaCl, 1 MgCl2, 10 HEPES, 0.05 EGTA, and 30 CsCl,pH adjusted to 7.2 with 
CsOH, and supplemented with amphotericin-B (300–500 μg/ml)

E (Extracellular) 10 tetraethylammonium chloride (TEA), 6 CsCl, 124 NaCl, 1 MgCl2, 2 CaCl2, 10 HEPES, and 10 glucose, pH 
adjusted to 7.3–7.4 with NaOH or CsOH, and 0.002–3 (2–3 mM) nifedipine
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Materials

Name Company Catalog Number Comments

5 ml polystyrene round-bottom tube Falcon 352054 Tubes for DS containing enzymes used in 
digestion steps

9-Phenanthrol Sigma-Aldrich 211281 TRPM4 channel inhibitor

Amphotericin-B Fisher BP928–250 Used for patch/cell perforation

Amphotericin-B European Pharmacopoeia 
Reference Standards

5 Used for patch/cell perforation

Amphotericin-B Sigma-Aldrich A9528–100MG Used for patch/cell perforation

Analog vortex mixer VWR 58816–121

Aspartic acid Sigma-Aldrich A9006 Intracellular pipette solution

Bovine serum albumin Sigma-Aldrich A7906 DS

CaCl2 Sigma-Aldrich C1016 Extracellular solution and DS

Capillary Glass Sutter BF150–110-7.5 Capillary for preparation of pulled patch 
electrodes

Cesium hydroxide hydrate Sigma-Aldrich C8518 Intracellular pipette solution

Clampex ver. 10 software includes data 
acqusition (Clampex) and analysis 
(Clampfit) programs

Axon Instruments/ 
Molecular Devices

pCLAMP-10 Commerical software and part of patch-clamp 
rig setup

Collagenase type 2 Worthington Biochemical 
Corporation

LS004177 DS-C

CsCl Sigma-Aldrich 203025 Extracellular and intracellular solutions

Dental wax Miltex Dental Wax 
Technologies, Inc.

18058351

Digital Thermometer with Probe Fisher Scientific 15–077-32 Placed in tissue bath to monitor temperature

Dimethyl sulfoxide (DMSO) Sigma-Aldrich D2650 Solvent

DL-Dithiothreitol (DDT) Sigma-Aldrich D9779 Reducing agents used together with Papain

EGTA Sigma-Aldrich E3889 Ca2+ chelator, used in intracellular pipette 
solution

Flaming/Brown micropipette puller Sutter P-97 Required to pull electrodes with very fine tips

Floating foam tube rack/holder VWR Scientific 82017–634 Used for holding tubes with enzymes for 
temperature control

Glucose Sigma G8270

Glutamic acid (Na salt) Sigma-Aldrich G1626 DS

HEPES Sigma-Aldrich H3375 pH Buffer

KCl Fisher Scientific BP366–1 Extracellular solution

Low Noise Data Acquisition System Axon Instruments/ 
Molecular Devices

Digidata 1440A Part of patch-clamp rig setup

Magnetic stirrer VWR 01–442-684

MgCl2 (hexahydrate) Sigma-Aldrich M2670 Extracellular and intracellular solutions

MicroForge Narishige MF-830 Used for fire-polishing electrodes

NaCl Sigma-Aldrich S7653 Extracellular and intracellular solutions

NaOH Sigma-Aldrich S8045

Nifedipine Sigma-Aldrich N7634 L-type voltage-gated Ca2+ channel blocker
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Name Company Catalog Number Comments

Nikon inverted microscope, TS100 
with T1-SM stage with 5x, 10x, 20x, 
and 40x objectives

Nikon Discontinued Part of Patch-clamp rig setup

Non-metalic syringe needle, MicroFil WPI MF-34G-5 Filling of intracellular pipette solution

Papain Worthington Biochemical 
Corporation

LS003126 DS-P

Pasteur pipette FisherBrand 13–678-20A Tips are broken off and fire- polished and 
used for titration of enzymatically treated 
tissues to release single DSM cells from 
pieces

Patch-clamp amplifier Axon Instruments/ 
Molecular Devices

Axon Axopatch 
200B

Part of patch-clamp rig setup

PC computer DELL Custom 
configuration

Part of patch-clamp rig setup

pH Meter Aspera Instruments PH700

Polyethylene tubing Intramedic 427–436 Tubing for superfusion of extracellular bath 
connected to glass-bottom recording chamber

Tetraethylammonium chloride Sigma-Aldrich T2265 Ion channel blocker of Kv and BK channels 
added to the extracellular bath solution

Thermo Scientific Precision shaking 
water bath (model 2870)

Thermo Scientific Discontinued Water bath for temperature control of 
enzymatic digestion employed as an 
alternative to tissue chamber-circulating bath 
setup

Tissue bath, 100 mL Radnoti 1583–101 Connected to a circulating bath and filled 
with water, tubes with DS and DSM pieces 
are placed in the setup to control the 
temperature of digestion steps

Vinyl tubing ColePalmer 06405–3 Multiple uses including for connecting tissue 
bath to circulating water bath

Water circulator bath, Haake D1 L Haake Discontinued Connected to tissue bath

Weighting scale Mettler Toledo XS64

ZeissAxiovert 40C inverted 
microscope with 10x and 40x 
objectives

Carl-Zeiss Discontinued Part of patch-clamp rig setup
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